Chapter 1

Introduction to
Autodesk Revit
Architecture 2016

Learning Objectives

After completing this chapter, you will be able to:

* Understand the basic concepts and principles of Revit Architecture 2016

* Understand different terms used in Revit Architecture

* Know the parametric behavior of Revit Architecture

* Use different components of the User Interface screen of Revit Architecture
* Access the Revit 2016 Help and Autodesk WikiHelp

* Know Worksharing using Revit Server
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INTRODUCTION TO Autodesk Revit Architecture

Welcome to the realm of Autodesk Revit Architecture, a powerful building modeler that has
changed the outlook of the building industry about computer aided designs. Autodesk Revit
Architecture is a design and documentation platform that enables you to use a single, integrated
building information model to conceptualize, design, and finally document a project. Its
integrated parametric modeling technology is used to create the information model of a project,
and to collect and coordinate information across all its representations. In Autodesk Revit
Architecture, drawing sheets, 2D views, 3D views, and schedules are a direct representation of the
same building information model. Using its parametric change engine, you can modify a design
at any stage of a project. The change in the project is automatically made and represented in all its
views, resulting in the development of better designs, along with an improved coordination. The
use of Autodesk Revit Architecture provides a competitive advantage and a higher profitability
to architects and building industry professionals.

Autodesk Revit Architecture AS A BUILDING
INFORMATION MODELER

The history of computer aided design and documentation dates back to the early 1980s
when architects began using this technology for documenting their projects. Realizing its
advantages, information sharing capabilities were developed, especially to share data with
other consultants. This led to the development of object-based CAD systems in the early 1990s.
Before the development of these systems, objects such as walls, doors, windows were stored
as a non-graphical data with the assigned graphics. These systems arranged the information
logically, but were unable to optimize its usage in a building project. Realizing the advantages
of the solid modeling tools, the mechanical and manufacturing industry professionals began
using the information modeling CAD technology. This technology enabled them to extract data
based on the relationship between model elements.

In 1997, a group of mechanical CAD technologists began working on a new software for
the building industry. The Building Information Modeling (BIM) provided an alternative
approach to building design, construction, and management. This approach, however, required a
suitable technology to implement and reap its benefits. In such a situation, the use of parametric
technology with the Building Information Modeling approach was envisaged as an ideal
combination. They developed a software that was suitable for creating building projects. This
led to the development of a software that later came to be known as Autodesk Revit Building,
and has now been changed to Autodesk Revit Architecture.

Autodesk Revit Architecture is a building design and documentation platform, in which a digital
building model is created using the parametric elements such as walls, doors, windows, and so
on. All the building elements have inherent relationship with one another, which can be tracked,
managed, and maintained by the computer.
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BASIC CONCEPTS AND PRINCIPLES

Autodesk Revit Architecture enables you to envisage and develop a building model with actual
3D parametric building elements. It provides a new approach to the architectural thought and
the implementation process. In a way, it replicates the way architects conceive a building. For
example, 2D CAD platforms mostly use lines to represent all elements, as shown in Figure 1-1.
However, in Autodesk Revit Architecture, you can create a building model using 3D elements
such as walls, floors, doors, and windows, as shown in Figure 1-2.
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Figure 1-1 CAD project created using 2D lines and curves
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Figure 1-2 Autodesk Revit Architecture project created using parametric
building model

Using these 3D elements, you can visualize the architectural or interior project with respect
to its scale, volume, and proportions. This enables you to study design alternatives and
develop superior quality design solutions. Autodesk Revit Architecture automates routine drafting
and coordination tasks and assists in reducing errors in documentation. This, in turn, saves time,
improves the speed of documentation, and lowers the cost for users.
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Understanding the Parametric Building Modeling Technology
A project in Autodesk Revit Architecture is created using the in-built parametric building
elements. The term parametric refers to the relationship parameters between various building
elements. Some relationships are made by Autodesk Revit Architecture itself, and others by the
user. For example, doors, which have an inherent parametric relationship with walls cannot
be created without first creating a host wall. A door always moves with the host wall. Similarly,
floors too are parametrically linked to walls. When you move walls, the floor extents are also
modified automatically. Each building element has in-built bidirectional associativity with many
other elements in the project.

A building information model is created using different interdependent parametric building
elements such as walls, floors, roof, ceiling, stairs, ramps, curtain walls, and so on. As they are
bidirectionally associated elements, any change made in one element is automatically adopted
by others. The integrated building information model thus created contains all the data for a
project. You can then create project presentation views such as plans, sections, elevations, and so
on for documentation. As you modify the model while working in certain views, Autodesk Revit
Architecture’s parametric change engine automatically updates other views. This capability is,
therefore, the underlying concept in Autodesk Revit Architecture.

Autodesk Revit Architecture’s parametric change engine enables you to modify design elements at
any stage of the project development. As changes are made immediately and automatically,
it saves the time and effort in coordinating them in all other associated views which for most
projects is an inevitable part of the design process. Autodesk Revit Architecture’s capability to
coordinate between various aspects of the building design provides immense flexibility in the
design and development process along with an error-free documentation.

Autodesk Revit Architecture also provides a variety of in-built parametric element libraries that
can be selected and used to create a building model. It also provides you with the flexibility of
modifying properties of these elements or create your own parametric elements based on the
project requirement.

Terms Used in Autodesk Revit Architecture

Before using Autodesk Revit Architecture, it is important to understand the basic terms used for
creating a building model. Various terms in Autodesk Revit Architecture such as project, level,
category, family, type, and instance are described next.

Autodesk Revit Architecture Project

A project in Autodesk Revit Architecture is similar to an actual architectural or interior project. In
an actual project, the entire documentation such as drawings, 3D views, specifications, schedules,
cost estimates, and so on are inherently linked and read together. Similarly, in Autodesk Revit
Architecture, a project not only includes the digital 3D building model but also its parametrically
associated documentation. Thus, all the components such as the building model, its standard
views, architectural drawings, and schedules combine together to form a complete project. A
project file contains all the project information such as building elements used in a project,
drawing sheets, schedules, cost estimates, 3D views, renderings, walkthroughs, and so on. A project
file also stores various settings such as environment, lighting, and so on. As data is stored in the
same file, it becomes easier for Autodesk Revit Architecture to coordinate the entire database.
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Levels in a Building Model

In Autodesk Revit Architecture, a building model is divided into different levels. These levels
may be understood as infinite horizontal planes that act as hosts for difterent elements such as
roof, floor, ceiling, and so on. The defined levels in a building model can in most cases relate
to difterent floor levels, or stories of the building project. Each element that you create belongs
to a particular level.

Subdivisions of Elements into Categories and Subcategories

Apart from building elements, an Autodesk Revit Architecture project also contains other
associated elements such as annotations, imported files, links, and so on. These elements have
been divided into following categories:

Model Categor : Consists of various building elements used in creating a buildin
gory g ¢le : g lding
model such as wall, floor, ceiling, roof, door, window, furniture,
stairs, curtain systems, ramps, and so on

Annotation Category : Consists of annotations such as dimensions, text notes, tags, symbols,
and so on

Datum Category : Consists of datums such as levels, grids, reference planes, and so
on

View Category : Consists of interactive project views such as floor plans, ceiling
plans, elevations, sections, 3D views, renderings, and
walkthroughs

In addition to these four categories, other categories such as Imported, Workset, Filter, and
Revit Categories can also exist if the project has imported files, enabled worksets, or linked
Autodesk Revit Architecture projects, respectively.

Families in Autodesk Revit Architecture

Another powerful concept in Autodesk Revit Architecture is family. A family is described as a
set of elements of the same category that can be grouped together based on certain common
parameters or characteristics. Elements of the same family may have different properties, but
they all have common characteristics. For example, Double Hung is a single window family,
but it contains different sizes of double hung windows. Family files have a .rfa extension. You
can load additional building component families from the libraries provided in Autodesk Revit
Architecture package.

Families are further divided into certain types. Type or family type, as it is called, is a specific
size or style of a family. For example, Double Hung : 36> x 48” is a window type. All uses of the
same family type in a project have same properties. Family and family types can also be used to
create new families using the Family Editor.

Instances are the actual usage of model elements in a building model or annotations in a
drawing sheet. A family type created in a new location is identified as an instance of the family
type. All instances of the same family type have same properties. Therefore, when you modify
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the properties of a family type, the properties of all its instances also get modified. The family
categorization of Revit elements is given below:

Model Category : Wall

Family : Basic Wall

Family type : Brick on Mtl. Studs

Instance : Particular usage of a family type

The hierarchy of building elements in Autodesk Revit Architecture plays an important role in
providing the flexibility and ease of managing a change in the building model. Figure 1-3 shows
the hierarchy of categories and families in a typical Autodesk Revit Architecture project. The
following is another example of the terms described in this section.

Autodesk Revit Elements

Model Category  Annotation Category Datum Category View Category
Walls Dimensions Grids Floor plans
Floors Text Notes Levels Ceiling plans
Roofs Tags Reference Planes Elevations
Ceilings Symbols Sections
Doors Keynotes 3D Views
Windows Callout views
Stairs Walkthroughs

Figure 1-3 Hierarchy of Autodesk Revit Architecture categories and families

Creating a Building Model Using Parametric Building
Elements

Another classification of categories of elements followed in Autodesk Revit Architecture is based
on their usage. Autodesk Revit Architecture uses five classes of elements: host, component,
annotation, view, and datum. Hosts are the element categories that form the basic structure of a
building model and include model elements such as walls, floor, roof, and ceiling. Components
are the elements that are added to host elements or act as stand-alone elements such as doors,
windows, and furniture. Annotations are the 2D, view-specific elements that add content to the
project documentation such as dimensions, tags, text notes, and so on. Views represent various
orientations of a building model such as plans, elevations, sections, 3D views, and so on. Datum
refers to the reference elements that assist you in creating a building model, which include grids,
levels, reference planes, and so on.

There is no specific methodology available for creating a building model in Autodesk Revit
Architecture. It provides you with the flexibility of generating building geometry based on the
project requirement, design complexity, and other factors. However, the following steps describe
a general procedure that may be followed for creating an architectural building model using
the in-built parametric elements provided in Autodesk Revit Architecture.
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The first step is to create the exterior walls of a building at the predefined lowest level (level 1).
Next, create interior walls at that level and add components to the building model. Then, define
the upper levels based on the story height of the building. You can also link the control height
of the walls to the levels and extend the exterior walls to their full height. Next, create floors
and roof using the defined levels. Add the site topography to the building model and then
add site components to complete the building project. You can then create drawing sheets with
the desired views for its presentation. Autodesk Revit Architecture also provides tools to create
rendered 3D views and walkthroughs. Figure 1-4 shows an example of a building section with
various building elements and annotations.
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Figure 1-4 Building section showing building elements and levels

Visibility/Graphics Overrides, Scale, and Detail Level

Autodesk Revit Architecture enables you to control the display and graphic representation
of a single element or the element category of various elements in project views by using the
visibility and graphics overrides tools. You can select a model category and modify its linetype
and detail level. This can also be done for various annotation category elements and imported
files. These settings can be done for each project view based on its desired representation. You
can also hide an element or an element category in a view using the Hide in View and Isolate
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tools. You can override the graphic representation of an element or an element category in any
view using the Visibility/Graphics tool.

The scale is another important concept in an Autodesk Revit Architecture project. You can
set the scale for each project view by selecting it from the available list of standard scales such
as 1/167=1°0", 1/4”’=1'07, 17=1°0", 1/2”=1’0", and so on. As you set a scale, Autodesk Revit
Architecture automatically sets the detail level appropriate for it. There are three detail levels
provided in an Autodesk Revit Architecture project: Coarse, Medium, and Fine. You can also
set the detail level manually for each project view. Each detail level has an associated linetype
and the detail lines associated with it. The details of annotations such as dimensions, tags, and
so on are also defined by the selected scale.

Extracting the Project Information

Asingle integrated building information is used to create and represent a building project. You
can extract project information from a building model and create area schemes, schedule, and
cost estimates, and then add them to the project presentation.

Autodesk Revit Architecture also enables you to export the extracted database to the industry
standard Open Database Connectivity (ODBC) compliant relational database tables. The use
of the building information model to extract database information eliminates the error-prone
method of measuring building spaces individually.

Creating an Architectural Drawing Set

After creating the building model, you can easily arrange the project views by plotting them on
drawing sheets. Drawing sheets can also be organized in a project file based on the established
CAD standards followed by the firm. In this manner, the project documentation can easily be
transformed from the conceptual design stage to the design development stage and finally to the
construction document stage. The project view on a drawing sheet is only a graphical representation
of the building information model and therefore, any modification in it is immediately made in
all the associated project views, keeping the drawings set always updated.

Creating an Unusual Building Geometry

Autodesk Revit Architecture also helps you conceptualize a building project in terms of its volume,
shape, and proportions before working with the actual building elements. This is possible by
using the Massing tool, which enables you to create quick 3D models of buildings and conduct
volumetric and proportion study on overall masses. It also enables you to visualize and create
an unusual building geometry. The same massing model can then be converted into a building
model with individual parametric building elements. It provides continuity in the generation
of building model right from sketch design to its development.

Flexibility of Creating Special Elements

Autodesk Revit Architecture provides a large number of in-built family types of various model
elements and annotations. Each parametric element has the associated properties that can be
modified based on the project requirement.
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Autodesk Revit Architecture also enables you to create the elements that are designed specifically
for a particular location. The in-built family editor enables you to create new elements using
family templates. This provides you with the flexibility of using in-built elements for creating
your own elements. For example, using the furniture template, you can create a reception desk
that is suitable for a particular location in the design.

Creating Structural Layouts

Autodesk Revit Architecture’s structural tools enable you to add structural elements to a
building model. An extensive in-built library of structural elements has been provided in Autodesk
Revit Architecture. You can add structural columns, beams, walls, braces, and so on to the project.
Thus, structural consultants can also incorporate their elements in the basic architectural building
model and check for inconsistency, if any.

Working on Large Projects

In Autodesk Revit Architecture, you can work on large projects by linking different
building projects together. For a large project that consists of a number of buildings, you can
create individual buildings as separate projects and then link all of them into a single base file.

The database recognizes the linked projects and includes them in the project representation
of the base file.

For example, while working on a large campus of an educational institution, you can create
separate project files for academic building, administration area, gymnasium, cafeteria, computer
centre, and so on, and then link them into the base site plan file. In this manner, large projects
can be subdivided and worked upon simultaneously.

Working in Large Teams and Coordinating with Consultants
Worksets in Autodesk Revit Architecture enable the division of the building model into small
editable set of elements. The worksets can be assigned to different teams working on the same
project and then their work can easily be coordinated in the central file location. The effort
required to coordinate, collaborate, and communicate the changes between various worksets is
taken care of by computer. Various consultants working on a project can be assigned a workset
with a set of editable elements. They can then incorporate their services and modify the
associated elements.

For example, a high rise commercial building project can be divided into different worksets
with independent teams working on exterior skin, interior walls, building core, toilet details,
finishes, and so on. The structural consultants can be assigned the exterior skin and the core
workset in which they can incorporate structural elements. Similarly, the rest of the teams can
work independently on different worksets.

STARTING Autodesk Revit Architecture 2016

When you turn on your computer, the operating system is automatically loaded. You can start
Autodesk Revit Architecture by double-clicking on the Revit Architecture 2016 icon on the
desktop. Alternatively, choose Start > All Programs > Autodesk > Revit Architecture 2016
> Revit Architecture 2016 from the taskbar, as shown in Figure 1-5; the user interface of Revit
Architecture 2016 will be displayed, as shown in Figure 1-6.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com
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Note
The path for starting Autodesk Revit Architecture depends on the operating system being used.

The interface screen has three sections: Projects, Families, and Resources. The options in the
Projects section are used to open an existing project, a new project, and an existing template.
The options in the Families section are used to open a new or an existing family. You can also
invoke the Conceptual Mass environment from this section to create a conceptual mass model.
If you choose the Autodesk Seek option from the Families section, you will be directed to the
hitp://seek.autodesk.com/localeTaxBrowse.htm 2category=en_us:adsk:revit-arch&locale=en-us&globaldd
=globaldropdown.option.b link and the Autodesk® Revit Architecture Web Library - US Edition
page will open. From this page, you can download various components for your project.

In the Resources section, you can choose the What’s New? option to get information about
the new tools and features in Autodesk Revit Structure 2016. In addition, you can choose
the Help option from the Resources section. On doing so, you will be directed to the link
http://help.autodesk.com/view/RVIT/2016/ENU. Also, the Autodesk Revit 2016 Help page with the
Welcome to Revit 2016 Learning area will be displayed. In the left of this page, the Contents and
the Search tab will be displayed. To access information related to additions and enhancements
in Revit 2016 release, you can expand the What’s New node from the Contents tab and then
choose the New in Revit 2016 link. On doing so, the New in Revit 2016 page will be displayed
with various links. You can know about various enhancements through these links.

In the Resources section, you can choose the Essential Skills Videos option to view the videos
related to basic and advance concepts in Autodesk Revit Architecture 2016. These videos and their
associated information help you to learn about the complete software. Moreover, you can choose
the Exchange Apps option to access various add-ons that can be used to enhance the productivity
of Revit. On choosing this option, the AUTODESK EXCHANGE | APPS page will be displayed.
In this page, various links are available as add-ons which can be used in Revit applications. In
the Revit Community option of the Resources section, you can access information related to
various communities and their contribution in the form of articles, tutorials, and videos.

In the Projects section, choose the Open option; the Open dialog box will be displayed. Browse
to the desired location in the dialog box and select the file. Now, choose the Open button to
open the file.

To open a new project file, choose the New option from the Projects section. Alternatively, choose
New > Project from the Application Menu; the New Project dialog box will be displayed. In
this dialog box, you can select the desired template from the Template file drop down or you
can browse the other template files, by choosing the Browse button from the Choose Template
dialog box. In this dialog box, make sure that the Project radio button is selected, and then
choose the OK button; a new project file will open and the interface screen will be activated.

USER INTERFACE

Autodesk Revit Architecture has ribbon interface. The ribbon which contains task-based tabs
and panels, streamlines the architectural workflow and optimizes the project delivery time. In
Autodesk Revit Architecture, when you select an element in the drawing area, the ribbon displays
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a contextual tab that comprises of tools corresponding to the selected element. The interface of
Autodesk Revit Architecture is similar to the interfaces of many other Microsoft Windows based
programs. The main parts in the Revit interface are Ribbon, Options Bar, Project Browser,

Drawing Area, Status Bar, and View Control Bar, as shown in Figure 1-7.
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Figure 1-7 The Autodesk Revit Architecture 2016 user interface screen

Invoking Tools

To perform an operation, you can invoke the required tools by using any one of the following
two options:

Ribbon: You can invoke all necessary tools from the ribbon.

Shortcut Keys: Some tools can also be invoked by using the keys on the keyboard.

Title Bar

The Title bar, docked on the top portion of the user interface, displays the program’s logo,
program’s name, name of the current project, and the view opened in the viewing area.
Project 1- Floor Plan: Level 1 is the default project and view.

Ribbon

The ribbon, as shown in Figure 1-8, is an interface that is used to invoke tools. When you open a
file, the ribbon is displayed at the top in the screen. It comprises of task-based tabs and panels,
refer to Figure 1-8, which provide all the tools necessary for creating a project. The tabs and
panels in the ribbon can be customized according to the need of the user. This can be done by
moving the panels and changing the view states of the ribbon (changing the ribbon view state is
discussed later in this chapter). The ribbon has three types of buttons are available in: general
button, drop-down button, and split button. These buttons can be invoked from the panels.
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Figure 1-8 Different components of a ribbon

Moving the Panels
In the ribbon, you can move a panel and place it anywhere on the screen. To do so, press and
hold the left mouse button on the panel label in the ribbon, drag it to some desired place on
the screen. Next, use the tools of the moved

; H
panel and place the panel back to the fr'c,\.@ %I% a %I% 47/&

Return Panels to Ribbon

ribbon. To do so, place the cursor on the By Shaft Wall Vertical Dormer
moved panel and choose the Return Face
Panels to Ribbon button from the upper Opening

right corner of this panel, as shown in
Figure 1-9; the panel will return to the
ribbon.

Figure 1-9 Choosing the Return Panels to Ribbon
button

Changing the View States of the Ribbon

The ribbon can be displayed in three view states by selecting any of the following four options:
Minimize to Tabs, Minimize to Panel Titles, Minimize to Panel Buttons, and Cycle through
All To use these options, move the cursor and place it over the second arrow on the right of
the Modify tab, refer to Figure 1-10 in the ribbon; the arrow will be highlighted. Now, click
on the down arrow; a flyout will be displayed, as shown in Figure 1-10. In this flyout, you can
choose the Minimize to Tabs option to display only the tabs in the ribbon. If you choose the
Minimize to Panel Titles option, the ribbon will display the titles of the panels along with the
tabs. You can choose the Minimize to Panel Buttons option to display the panels as buttons in
the ribbon along with tabs.
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Figure 1-10 larious options in the flyout for changing the view state of the ribbon

Tip: Tooltips appear when you vest the cursor over any of the tool icons in the ribbon. The
name of the tool appears in the box helping you to identify each tool icon.

: Note

@ If the view state of the ribbon is changed, place the cursor over the furst arrow at the right of the
Modify tab, the Show Full Ribbon tooltip will be displayed. Click on the arrow; full ribbon will
be displayed.

Evaluation Copy. Do not reproduce. For information visit www.cadcim.com



1-14

Autodesk Revit Architecture for Architects and Designers

The following table describes various tabs in the ribbon and their functions:

Tab Description

Architecture Contains tools for creating architectural elements for a
project

Structure Contains tools for creating structural elements in a project

Create This tab is available in family editor. It contains tools that are
used to create a family

Insert Contains tools to insert or manage secondary files such as
raster image files or CAD files

Annotate Contains tools for documenting a building model such as

adding texts and dimensions

Massing & Site

Contains tools for modeling and modifying conceptual mass
and site elements

Analyze Contains tools for energy analysis of the project

Collaborate Contains tools for collaborating the project with other team
members (internal and external)

View Contains tools used for managing and modifying the current
view and also for switching views

Manage Contains tools for specifying the project and system parameters and
project settings

Modity Contains tools for editing elements in the model

Contextual Tabs in the Ribbon

These tabs are displayed when you choose certain tools or select elements. These tabs contain
a set of tools or buttons that relate only to a particular tool or element. For example, when you
invoke the Window tool, the Modify | Place Window contextual tab is displayed. This tab shows
ten panels: Select, Properties, View, Measure, Geometry, Clipboard, Create, Modify, Mode, and
Tag. The Select panel contains the Modify tool. The Properties panel contains the Properties
button and the Type Properties tool. The Mode panel has some necessary tools that are used
to load model families or to create the model of a window in a drawing. The other panels, apart
from those discussed above, contain the tools that are contextual and are used to edit elements
when they are placed in a drawing or selected from a drawing for modification.

Application Frame

The application frame helps you manage projects in Autodesk Revit Architecture. It consists of
Application button, Application Menu, Quick Access Toolbar, InfoCenter, and Status Bar.
These are discussed next.
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Application Button
The Application button is displayed at the top-left corner of the Revit interface. This button is
used to display as well as close the Application Menu.

Application Menu

The Application Menu contains the tools that provide access to many common file actions
such as Open, Close, and Save. Click the down arrow on the Application button to display the
Application Menu, as shown in Figure 1-11. Alternatively, press ALT+F to display tools in the
Application Menu.
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Exit Revit

Figure 1-11 The Application Menu

Quick Access Toolbar
The Quick Access Toolbar, as shown in Figure 1-12, contains the options to undo and redo
changes, open and save a file, create a new file, and so on.

By default, the Quick Access Toolbar contains the following options: Open, Save, Redo, Undo,
and others. You can customize the display of the Quick Access Toolbar by adding more tools
and removing the unwanted tools. To add a tool or a button from the panel of the ribbon to
the Quick Access Toolbar, place the cursor over the button; the button will be highlighted.
Next, right-click; a flyout will be displayed. Choose Add Quick Access Toolbar from the flyout
displayed; the highlighted button will be added to Quick Access Toolbar. The Quick Access
Toolbar can be customized to re-order the tools displayed in it. To do so, choose the down arrow
next to the Switch Windows drop-down, refer to Figure 1-12; a flyout will be displayed. Choose
the Customize Quick Access Toolbar option located at the bottom of the flyout; the Customize
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Quick Access Toolbar dialog box will be displayed. Use various options in this dialog box and
choose the OK button; the Customize Quick Access Toolbar dialog box will close and the tools
in the Quick Access Toolbar will be re-ordered.

EH - Q-0 2- S 0A B-0E GS-T

AL
Open _ L lUndo Text _ L

Shynchronize Mo

Switch Windows drop-down
Default 3D View drop-down

Save
Figure 1-12 The Quick Access Toolbar

InfoCenter

You can use the InfoCenter to search the information related to Revit Architecture (Help), display
the Comunication Center panel for subscription services and product updates, and display the
Favorites panel to access saved topics. Also in the InfoCenter, you can use the Autodesk 360 and
the Exchange Apps options to log-in to Autodesk 360 and Autodesk Exchange Apps pages.
Figure 1-13 displays various tools in the InfoCenter.

Communication Center Favorites
Autodesk 360
Search Exchange Apps
* | Type a keyword or phrase ;a § & cadcim ~ @ ~
Search Field J Help drop-down

Figure 1-13 The InfoCenter

Status Bar

The Status Bar is located at the bottom of the interface screen. When the cursor is placed
over an element or component, the Status Bar displays the name of the family and type of the
corresponding element or components. It also displays prompts and messages to help you use
the selected tools.

View Control Bar

The View Control Bar is located at the lower left corner of the drawing window, as shown in
Figure 1-14. It can be used to access various view-related tools. The Scale button shows the scale
of the current view. You can choose this button to display a flyout that contains standard drawing
scales. From this flyout, you can then select the scale for the current view. The Detail Level
button is used to set the detail level of a view. You can select the required detail level as Coarse,
Medium, and Fine. Similarly, the Visual Style button enables you to set the display style. The
options for setting the display style are: Wireframe, Hidden Line, Shaded, Consistent Colors,
Realistic, and Raytrace.

Options Bar

The Options Bar provides information about the common parameters of component type and
the options for creating or editing. The Options Bar changes its appearance based on the type
of component selected or being created. You can also modify the properties of the component
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by entering a new value in the edit box for the corresponding parameter in the Options Bar.
For example, the Options Bar for the Wall tool displays various options to create a wall, as
shown in Figure 1-15.
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Rendering dialog Hide/lsolate
Reveal Hidden
Crop View Elements

Figure 1-14 The View Control Bar

Medify | Place Wall Height Uncone » 20' 0" Location Line: Wall Centerline ~ [#]Chain  Offeet: 0" 0" [|Radiust | 1' 0"

Figure 1-15 The Options Bar with different options to create a wall

Type Selector

The Type Selector drop-down list is located in the Properties palette of the currently invoked
tool. For example, if you invoke the Wall tool, all the properties of the wall will be displayed in
the Properties palette. In the Properties palette, you can use the Type Selector drop-down list
to select the required type of the wall. The options in the Type Selector drop-down list keep on
changing based on the current function of the tool or the elements selected. When you place an
element or a component in a drawing, you can use the Type Selector drop-down list to specify
the type of element or component. You can also use this drop-down list to change the existing
type of a selected element to a different type. In Autodesk Revit Architecture, you can add the
Type Selector drop-down list to the Quick Access Toolbar. To do so, right-click on the Type
Selector drop-down list in the Properties palette and choose the Quick Access Toolbar option
from the flyout displayed.

Drawing Area

The Drawing Area is the actual modeling area where you can create and view the building model.
It covers the major portion of the interface screen. You can draw various building components in
this area using the pointing device. The position of the pointing device is represented by the
cursor. The Drawing Area also has the standard Microsoft Windows functions and buttons such
as close, minimize, maximize, scroll bar, and so on. These buttons have the same function as
that of the other Microsoft Windows-based programs.
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Project Browser Prajectl - Project Browser (=
The Project Browser is located below the ribbon. It displays £, Views (al)
project views, schedules, sheets, families, and groups in a = F'°°L'GTZT;
logical, tree-like structure, as shown in Figure 1-16, and Level 2
helps you open and manage them. To open a view, - Site
double-click on the name of the view; the corresponding = CE"'LEZ'Z"S
view will be displayed in the drawing area. You can close Level 2
the Project Browser or dock it anywhere in the drawing =] Elevztic;nsiﬁuilding Elevation)
asl
area. -

South

, Note West
@ If the Project Browser is not displayed on the screen, Legends

choose the View tab from the ribbon and then click on =3 Sﬁ?ej”'esﬁu?ﬁiﬁes
the User Interface drop-down from the Windqws Sh!;t::nc R
panel. Next, select the Project Browser check box from B Families

the flyout displayed. [@ Groups

& Revit Links

The Project Browser can be organized to group the views ] ]
and sheets based on the project requirement. For example, ~ Figure 1-16 The Project Browser
while working on a large project with a number of sheets,

you can organize the Project Browser to view and access specific sheets.

Note

@ In the Project Browser, you can expand or collapse the view listing by selecting the ‘+ or -’ sign,
respectively. The current view in the drawing window s highlighted in bold letters. The default
project file has a set of preloaded views.

Keyboard Accelerators

In Autodesk Revit Architecture, accelerator keys have been assigned to some of the frequently
used tools. These keys are shortcuts that you can type through the keyboard to invoke the
corresponding tool. Accelerator keys corresponding to a tool appear as a tooltip when you move
the cursor over the tool. In Autodesk Revit Architecture 2016, you can export all commands
(even if they do not have shortcut keys assigned) to a XML file. You can further edit the XML
file to assign shortcut keys to commands, and then import them back to be used in Revit.

Keyboard Accelerators quite useful because they save the effort of browsing through the
menus.

Q Tip: As you become accustomed to using Autodesk Revit Architecture, you will find these

Properties palette

The Properties palette, as shown in Figure 1-17, is a modeless interface, which displays the type
and element properties of various elements and views in a drawing. Properties palette is dockable
and resizable, and it supports multiple monitor configurations. The Properties palette is
displayed in the Revit interface by default and it shows the instance properties of an active view.
When you select an element from a drawing, the Properties palette displays its instance
properties. You can also access the Type Properties of the selected element from the Properties
palette. To do so, choose the Edit Type button from the palette; the Type Properties dialog
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boxwillbe displayed. In this dialogbox, you can .
. Properties (2]

change the Type Properties of the selected
element. In the Properties palette, you can | Type Selector
assign a type to a selected element in a drop-down st
Qrawmg erm thg Type Selector drop-down |-~ =) 88 et ype £t Type buton
list. In Revit Architecture, you can toggle the | Froii .
display of the Properties palette in its View Scale U8 = 10 —
interface. Choose the Properties button in cealealue L 16

. . Display Maodel Marmal -
the Properties panel of the Modify tab to Bl Lo o 3
hide it. Similarly, you can choose the Visibility/Graphics O... Edit...
Properties button to display the palette if'it Visual Style ... Hidden Line | Instance
is not visible in the interface. Emph" Display Optt:. | L Properties

nderlay Mone
Underlay Orientation | Plan
DIALOG BOXES Orientation Praject Marth
Wall Join Display Clean all wall joins
Certain Autodesk Revit Architecture tools E“I‘ipgf‘;‘ o~ g‘"tit““'”l"
when invoked display a dialog box. A dialog Lo Pt [ s gm:'r::ne)
box is a convenient method of accessing and T ————
. Properties help Apply

modifying the parameters related to that

tool. For example, when you choose Save
As > Project from the Application Menu,
the Save As dialog box will be displayed, as
shown in Figure 1-18. A dialog box consists of various parts such as dialog label, radio buttons,
text or edit boxes, check boxes, slider bars, image box, and tool buttons, which are similar to other
windows-based programs. Some dialog boxes contain the [...] button. On choosing such buttons,
another related dialog box will be displayed. There are certain buttons such as OK, Cancel, and
Help, which appear at the bottom of most of the dialog boxes. The names of the buttons imply
their respective functions. The button with a dark border is the default button.

Figure 1-17 The Properties palelte
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Figure 1-18 The Save As dialog box
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MULTIPLE DOCUMENT ENVIRONMENT

The multiple document environment feature allows you to open more than one project at a time
in a single Autodesk Revit Architecture session. This is very useful when you want to work on
different pro jects simultaneously and make changes with reference to each other.

Sometimes, you may need to incorporate certain

features from one project into the other. With the help E i}
of m}lltlple QOcument environments, you can open Someh B Ueer
multiple projects and then use the Cut, Copy, and Windows | 2 Inteface’
Paste tools from the Clipboard panel of the Modify 1 Projectl - Floor Plan: Level 1
(type of element) tab to transfer the required 2 project] - 30 Views {30}
components from one project to another. These 3 projectl. - Floor Plan: Level 1

editing tools can also be invoked by using the
CTRL+C and CTRL+V keyboard shortcuts.

4 project] - Floor Plan: Level 2
5 figure 6-41 - Floor Plan: Level 1

To access the opened projects, choose the Switch 6 c04_Club_tut2 - Floor Plan: First Floor
Windows drop-down from the Windows panel of the v 7 c04_Club_tut? - Elevation: East
View tab; a menu will be displayed showing the name
of different project files opened, as shown in Figure
1-19. Like other Microsoft Windows-based programs,
you can select and view the opened projects using the
Cascade and Tile tools from the Windows panel of the View tab. The cascaded view of projects,
as shown in Figure 1-20.

Figure 1-19 Selecting an option from
the Switch Windows drop-down
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Figure 1-20 The cascaded view of the projects

INTEROPERABILITY OF Autodesk Revit Architecture

The models or geometries created in Revit Architecture can easily be exported to AutoCAD
based programs, such as 3ds Max and Max Design in the DWG file format. This enables you
to visualize and create photorealistic exterior and interior renderings for your project designs.
You can also transfer drawings from Revit Architecture to Google SketchUp to visualize your
projects in a better way.
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Revit Architecture 2016 follows a wide range of industry standards and supports various CAD file
formats such as DWG, DXF, DWF, DGN, FBX, and SAT. For image files, it supports JPG, TIFE,
BMP, PNG, AVI, PAN, IVR, and TGA file formats. Besides these, the formats that are supported
by Revit Architecture include ODBC, HTML, TXT, gbXML, XLS, and MDB. Revit Architecture
is compatible with any CAD system that supports the DWG, DXF, or DGN file format. Revit
Architecture can import the models and geometries as ACIS solids. This enables designers to
import models from AutoCAD Architecture and AutoCAD MEP (Mechanical, Electrical, and
Plumbing) software and to link and import 3D information to Revit Architecture. This feature
makes Autodesk Revit Architecture 2016 an efficient, user-friendly, and compatible software.

In Autodesk Revit Architecture 2016, you can directly link the Revit files into 3ds Max Design
and load selected views in it. You can also override material in 3ds Max Design and retain its
settings when you reload Revit link file. Also, in 3ds Max Design, you can add high level of
details to the curved objects to make them smooth. In Autodesk Revit Architecture 2016, the
interoperability with V8 Microstation has been introduced. The V8 Microstation files can be
imported to the Revit project. In addition to these, mapping functionality for levels, lines, line
weights, patterns, and texts and fonts has been added to the export DGN workflow.

BUILDING INFORMATION MODELING AND Autodesk
Revit Architecture 2016

Building Information Modeling (BIM) is defined as a design technology that involves creation and
use of coordinated, internally consistent, and computable information about a building project
in design and construction. BIM covers spatial relationships, geographic information, quantities,
and properties of building components. Using this technology, you can demonstrate the entire
life cycle of a building project starting from the process of construction, facility operation, and
information about quantities and shared properties of elements. BIM enables the circulation of
virtual information model from the design team to contractors and then to the owner, thereby
adding changes and their knowledge to update the model at each stage of transfer. The ability to
keep information up-to-date and make it available in an integrated digital environment enables
the architects, owners, builders, and engineers to have clear vision of the project before the
commencement of actual construction. It enables them to make better and faster decisions as
well as to improve the quality and profitability of projects. Autodesk Revit Architecture 2016 is
a specially designed platform based on BIM. Revit Architecture 2016 is the best example of the
BIM technology. Revit Architecture’s parametric model represents a building as an integrated
database of coordinated information. In Revit, change anywhere is change everywhere. Any
change made in your project at any stage is reflected in the entire project, and also, due to the
parametric behavior of elements, the project is updated automatically according to the changes
made anywhere in the project. Also, the integration of Revit Architecture with the available in-
built commercial tools such as solar studies, material takeofts, greatly simplifies the project design
and reduces the time consumed by these analyses, thereby enabling faster decision making.

Autodesk Revit Architecture HELP

Autodesk Revit Architecture provides help to easily understand various tools and methods
used in it. In Autodesk Revit Architecture 2016, you can access online help documentation. To
access the help feature, click on the Help down arrow on the right of the InfoCenter; a flyout
containing help options will be displayed, as shown in Figure 1-21. Various options to access
the help are discussed next.
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Figure 1-21 A drop-down menu displaying help options
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Using the Revit Architecture 2016 Help
You can access Revit Architecture 2016 help when you are online. To do so, choose the Help
tool from the InfoCenter bar; the Revit Help page will be displayed, as shown in Figure 1-22.
In this page, there are several tabs that contain information of help topics. These tabs are

discussed next.
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Figure 1-22 The partial view of the Revit Help page

Contents Tab

Signin @ English
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£\ AUTODESK. Knowledge Network

By default, this tab is chosen in the Revit Help page. In this tab, the New in Revit 2016 link is
selected by default. As a result, the New in Revit 2016 page is displayed with the information
about the new and enhanced features that are introduced in Autodesk Revit Architecture
2016. Information related to various features such as Platform Enhancement, Architectural
Enhancement, MEP Enhancement, Structural Enhancement, and Revit Server is displayed on

this page.
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On expanding the Revit Users option, various options such as What’s New, Introduction to
Revit, Start a Project, and so on will be displayed. You can use these options to access information
about the new features introduced, how to start a project and so on. On expanding the BIM
Managers option, information related to Revit 2016 Administration, Revit Server, and so on
is displayed. On expanding the Installation option, you can access information regarding the
system requirement, Revit installation overview, Revit Server installation method, and so on.

The subscription feature links such as Revit Server, Essential Skill Videos, Technical Support
and Legal Notices help you to know about the add-ons that are available to the subscribers.

Search Tab

In Autodesk Revit Architecture, you can access the help files. To do so, choose the Search tab; a
page that will help you to search topics in Revit will be displayed. Type a keyword in the Search
help for edit box and choose the Search button; the topics related to the search will be displayed
in the area below the edit box. In the Search method area, you can use various options to do
advanced searches regarding the related topics in Revit.

WORKSHARING USING REVIT SERVER

Worksharing is a method of distributing work among team involved in a project, and
accomplishing it within the stipulated period of time. In worksharing, each person involved in
the project is assigned a task that has to be accomplished by proper planning and by coordinating
with the other members of the team.

In a large scale building project, worksharing helps in finishing a project in time and meeting
the quality requirements that are set during the process. Generally, in a large scale building
project, worksharing is based on the specialization of work. The professionals such as structural
engineers, architects, interior architects, and MEP engineers are involved in their respective
fields to accomplish the project. So, the distribution of work at the primary stage is made on
the basis of the area of specialization. Each professional has his own set of work to perform for
the accomplishment of the project.

In Autodesk Revit Architecture 2016, you can apply server-based worksharing with the help of
Revit Server, which is a server application. Revit Server uses a central server and multiple local
servers for collaborating across a Wide Area Network (WAN). The central server hosts the central
model of a workshared project and remain accessible to all the team members over the Wide Area
Network. Similarly, the local server is accessible to all team members in a Local Area Network
(LAN). The local server hosts a local updated copy of the central model. In the Worksharing
environment, the team members are not aware of the local server, as it is transparent in their
daily operations. Refer to Figure 1-23 for the network model of Revit Server.

In Worksharing environment, a team member starts working on the local model of the central
model. The local model will be saved in the computer of the team member. As the team member
works, the local server requests updated information from the central model on the central server
using available network capacity to transfer the data over the WAN. The updated version of the
model is stored on the local server, so the updates are readily available when a team member
requests them.
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Figure 1-23 The Network model of Revit Server

WORKING WITH BIM 360

In Revit Architecture 2016, BIM 360 has been introduced as an add-in. BIM 360 is a cloud based
BIM management and collaboration solution. It is used for publishing models on the BIM 360
cloud and for sharing latest project information within a team. This add-in allows you to perform
several functions such as opening model from BIM 360 Glue to Architecture, appending models
from BIM 360 Glue to the current model in Architecture, and sharing models with BIM 360
Glue. These functions are discussed next.

Sharing Models With BIM 360

In BIM 360, you can use the Glue tool to share models with the BIM 360 cloud, which can be
shared further within a team. To share model with the cloud, first load the desired model in
Revit Architecture and ensure that you are signed in to the autodesk account then choose the
Glue tool from the BIM 360 panel in the Add-Ins tab; the BIM 360 GLUE apps page will be
displayed. Next, you need to sign in with your Autodesk ID and password, and specify a name
for the BIM 360 page. Now, you will be registered to the BIM 360 page. Follow the instructions
mentioned on the apps page and install BIM 360 cloud application. When the installation gets
over Autodesk BIM 360 app page will be displayed with the project. Close the dialog box and
open the Revit software.
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/ Note
@ If you are not signed in to Autodesk account then on choosing the Glue tool, the Autodesk-Sign
\ In dialog box will be displayed and will prompt you to sign in .

In Revit, if you are signed in to the autodesk account then on choosing the Glue tool, the Select
Project dialog box will be displayed, as shown in Figure 1-24. Select the Sample Project and

then choose the Next button in the dialog box; the Select Views dialog box will be displayed,
as shown in Figure 1-25.
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Figure 1-24 The Select Project dialog box
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Figure 1-25 The Select Views dialog
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In this dialog box, select the check box corresponding to the required view and then choose the
Next button; the Review and Confirm dialog box will be displayed, as shown in Figure 1-26.

Review and Confirm

Hotel_project Sample Project

MName Folder [optional) Last Glued

Living Room + Add to Folder New

More options Back m

Figure 1-26 The Review and Confirm dialog box

In this dialog box, you can select the required folder from the Folder column. To select the
folder click under the Folder(optional) column; the Add to Folder dialog box will be displayed,
as shown in Figure 1-27. In this dialog box, select the required folder and choose the Select
button; the Add to Folder dialog box will be closed and the Review and Confirm dialog box will
be displayed. In the Review and Confirm dialog box, choose the Glue It button; the Gluing in
Progress message box will be displayed. Choose the OK button; the message box will be closed.
After sometime, the Gluing Complete message box will be displayed. Choose the OK button;
the model will be shared with the BIM 360 cloud.

Add to Folder

Select location +

Figure 1-27 The Add to Folder dialog box



